CBSE – DEPARTMENT OF SKILL EDUCATION
MEDIA – SUBJECT CODE 415
MARKING SCHEME
Class X (Session 2019–2020)
Time: 2 Hours

Max. Marks: 50

General Instructions:
1. This Question Paper consists of two parts viz. Part A: Employability Skills and Part B: Subject
Skills.
2. Part A: Employability Skills (10 Marks)
i.
Answer any 4 questions out of the given 6 questions of 1 mark each.
ii.
Answer any 3 questions out of the given 5 questions of 2 marks each.
3. Part B: Subject Skills (40 Marks):
i.
Answer any 10 questions out of the given 12 questions of 1 mark each.
ii.
Answer any 4 questions from the given 6 questions of 2 marks each.
iii.
Answer any 4 questions from the given 6 questions of 3 marks each.
iv.
Answer any 2 questions from the given 4 questions of 5 marks each.
4. This question paper contains 39 questions out of which 27 questions are to be answered.
5. All questions of a particular part/section must be attempted in the correct order.
6. The maximum time allowed is 2 hrs.

PART A: EMPLOYABILITY SKILLS (10 MARKS)
Answer any 4 questions out of the given 6 questions of 1 mark each:
1.

2.

Which of the following methods are used to receive information from the sender through a
letter?
(d) Writing
Grooming is a term associated with
(c) neat and clean appearance

(1)

(1)

3.

Which of the following is not a self-management skill?
(b) Bargaining

(1)

4.

What does GPS stand for?
(a) Global Positioning System

(1)

5.

What is the aim of entrepreneurship?
(c) Both of the above

(1)
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6.

What are some of the environmental changes caused due to modern methods of
agriculture?
(a) Chemical pollution due to fertilizers

(1)

Answer any 3 questions out of the given 5 questions of 2 marks each:
7.

8.

9.

10.

11.

What are the five sources of energy available to us?
There are 5 fundamental sources of energy :
(i) Nuclear fusion in the Sun (solar energy),
(ii) Gravity generated by the Earth and Moon,
(iii) Nuclear fission reactions,
(iv) Energy in the interior of the Earth, and
(v) Energy stored in chemical bonds. Most of the energy we use today come from fossil
fuels (stored solar energy). But fossils fuels have a disadvantage in that they are nonrenewable on a human time scale, and causes other potentially harmful effects on the
environment.
List any four characteristics of entrepreneurship.
1. Ability to take up risks
2. Believe in hard work and discipline
3. Adaptable and flexible to achieve the goals of enhancing quality and customer
satisfaction
4. Knowledge of the product and services and their need or demand in the market
5. Financial literacy and money management skills
6. Effective planning and execution.
List the steps to search for information using a web browser.
To see the information on the various websites, you need an Internet Browser. An Internet
Browser is an application or a software program on your computer or laptop which helps
you visit the various websites. Some examples of browsers are Google Chrome, Mozilla
Firefox and Internet Explorer.
Searching for information: Do the steps below to search for information on the Internet.
- Open an Internet browser
- Type the topic, on which you want information, in the search box and hit the Enter
key.
- The search results having the required information will be displayed.
Click Firefox icon to open Firefox Mozilla browser and search for information.

(2)

What are the factors that affect self-confidence?
Given below are some factors that affects self-confidence.
(a) When we think we cannot do a particular work.
(b) When we keep thinking of our past mistakes and feel bad about it, instead of learning
from them.
(c) When we expect to be successful at the first attempt itself and do not try again.
(d) When we are surrounded by people who have a negative attitude, which is reflected in
their speech.
Write down the different types of verbal communication.
Give an example for each type.
Oral or Spoken Communication: Communication which involves talking. Face-to-face
conversation, Talking on a phone
Written Communication: Communication which involves written or typed words.
Writing letters, notes, email, etc.

(2)
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(2)

(2)

(2)

PART B: SUBJECT SKILLS (40 MARKS)
Answer any 10 questions out of the given 12 questions:
12.

Provides quick access to various options related to creating large complex scenes.
1. Scene Assembly

(1)

13.

Opens the current object's shader node in the Attribute Editor

(1)

2. Material Attributes
14.

Allows you to drag UVs directly in the viewport.

(1)

1. 3D Grab UV Tool

15.

In Maya. Materials also called as:
1. Shades

16.

A color background floods the background of the scene with
1. Solid Color

17.

You can map a texture to any of the material attributes that appear with which icon of the
following?

(1)

?

(1)

(1)

1.
18.

Environment textures are commonly used either as backgrounds for objects in your scene
or as
maps.
1. Reflection Maps

(1)

19.

Exposure is available only for File texture nodes.
1. True

(1)

20.

The 2D representation of the 3D model (or the UV’s) is a
1. Flattened

21.

Bump maps cannot cast or receive shadows
1. True

Version.

(1)

(1)

22.

(1)
Scratches are like little depressions, you can more easily achieve them with
version
1. 2D

23.

Because high pass exists as a separate layer, you can adjust the layer’s
Blending Modes to control the strength of sharpening over the entire image.
1. Opacity
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and

(1)

Answer any 4 questions out of the given 6 questions of 2 marks each:
Mention the functions of Status Line hotkeys which are F2, F3, F4, F5, F6.
Ans.
F2 (Modeling)
F3 (Rigging)
F4 (Animation)
F5 (FX)
F6 ( Rendering)
What is Bump Maps? Explain in brief.
Ans. Bump maps are grayscale textures you map to objects to create the illusion of surface
relief on an otherwise flat object.

(2)

26.

What is UV Mapping?
Ans. The process of creating explicit UVs for a surface mesh is called UV mapping.

(2)

27.

Mention the Techniques of UV mapping.
Ans.
 Automatic UV mapping
 Planar UV mapping
 Cylindrical UV mapping
 Spherical UV mapping
 User-defined UV mapping
 Best Plane mapping
Camera UV mapping - see Planar UV mapping
What is Diffuse Map? Explain in brief.
Ans. The diffuse map is a tillable (usually) image which gives the color information, but
does not contain lighting or height information for the texture.

(2)

What is Displacement Maps? Explain in brief.
Ans. Displacement maps are grayscale textures you map to objects to create true surface
relief (elevations and depressions) on an otherwise flat object.

(2)

24.

25.

28.

29.

(2)

(2)

Answer any 4 questions out of the given 6 questions of 3 marks each:
30.

What are Marking Menus?
Ans. Marking menus are used throughout the Maya interface. When you right-click an
object, a marking menu appears that lets you select a selection mode and other actions that
are in context to the type of object. Some marking menus appear when you hold a key and
press a mouse button.
Marking menus are very fast for experienced users because once you get used to showing
them and the positions of their items, you can select the items using very quick gestures
with the mouse or tablet pen, sometimes so fast the entire menu won’t even display.

(3)

31.

What is the use of Help Line?
Ans. The Help Line gives a short description of tools and menu items as you scroll over
them in the UI. This bar also prompts you with the steps required to use a tool or complete
a workflow.

(3)
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32.

Explain how to create a texture background.
Ans.
1. In the Environment section of the camera’s Attribute Editor (View > Camera
Attribute Editor), click the Create button to the right of the Image Plane attribute.
Maya creates an image plane and connects it to the camera.
2. Set the Type attribute for the image plane to Texture.
3. Click the texture button for the Texture attribute. The Create Render Node window
appears.
4. 4. Select the texture you want to use as a background (for example, an Environment
Texture). Maya creates the texture and connects it to the image plane.

(3)

33.

Explain how to set the position of Image Plane.
Ans.
 Use the Placement attributes to position an image plane relative to the camera.
 Use the Placement Extras attributes to control which portion of an image file is
visible on the image plane.

(3)

34.

Explain how to create a Bump map in Maya.
Ans. Bump maps are grayscale textures you map to objects to create the illusion of surface
relief (elevations and depressions) on an otherwise flat object.
With bump maps, depressions and elevations look real because they don’t alter the
geometry of the surface the way Displacement maps do. Bump maps just change the
direction of the surface’s normal based on the bump map’s Alpha Gain value.
Use bump maps to create very shallow reliefs. For example, you can make objects look
like they are embossed, have shallow rolling hills, and so on.
Because bump maps are not true surface relief, they:
 cannot cast or receive shadows
 cannot be seen if you silhouette the mapped object
 take less time to render than displacement maps

(3)

35.

What is IOR?
Ans. The IOR parameter (Index of Refraction) defines the material's Fresnel reflectivity
and is by default the angular function used. Effectively the IOR will define the balance
between reflections on surfaces facing the viewer and on surface edges.

(3)

Answer any 2 questions out of the given 4 questions of 5 marks each:
36.

Explain Interface overview in Maya with suitable example.
Ans: There are a lot of items displayed in the Maya user interface which are as follows:
1. Menu Bar: The Main Menu bar appears at the top of the Maya interface directly below the
Maya title bar and displays the chosen menu set. Each menu set corresponds to a module
within Maya: Animation, Polygons, Surfaces, Rendering, and Dynamics. Modules are a
method for grouping related features and tools.
2. Status Line: The Status Line, located directly below the Main Menu bar, contains a variety
of items, most of which are used while modeling or working with objects within Maya.
Many of the Status Line items are represented by a graphical icon. The icons save space in
the Maya interface and allow for quick access to tools used most often.
3. Shelf: The Shelf is located directly below the Status line. The Maya Shelf is useful for
storing tools and items that you use frequently or have customized for your own use. You
can keep the tools and items you use most frequently in a location that provides handy
access. Maya has some of the Shelf items pre-configured for your use.
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(5)

4. Workspace: The Maya workspace is where you conduct most of your work within Maya.
The workspace is the central window where your objects and most editor panels appear.




The panel is labeled persp at the bottom to indicate that you are viewing the Maya scene
from a perspective camera view.
The panel has its own menu bar at the top left corner of the panel. These menus allow you
to access tools and functions related to that specific panel.
The grid is displayed with two heavy lines intersecting at the center of the Maya scene. This
central location is called the origin. The origin is the center of Maya’s 3D world, and with
all object’s directional values measured from this location.

5. Channel Box: The Channel Box is the primary, fastest, and most streamlined tool for
editing object attributes. It lets you quickly change attribute values, set keys on keyable
attributes, lock or unlock attributes, and create expressions on attributes.
6. Quick Layout Buttons: The quick layout buttons display just below the Tool Box and let
you switch between useful panel layouts
7. Toolbox: The Tool Box displays on the left side of the Maya interface by It contains the
most commonly-used tools for working in Maya like., Move, Rotate, Scale and Last used
tool
8. Command Line: The command line lets you type single MEL or Python commands
without having to open the Script editor. You can switch between MEL and Python mode
by clicking the MEL/Python button. The result from the command appears in the output
9. Time and Range Slider: The Time Slider controls the playback range, keys, and
breakdowns within the playback range
37.

How to apply Texture mapping Explain?

(5)

Ans: To apply a texture to an object, you map the texture to an attribute on the object's material.
The attribute to which the texture is connected determines how the texture is used and how it affects
the final output.
To map a texture to a material using the Attribute Editor
1. Select your material in the Hypershade. In the material Attribute Editor, click the map button
beside the attribute that you want to connect a texture to. The Create Render Node window
appears.
2. Select a texture from the Create Render Node window.
If you are selecting a 2D texture, right-click the texture and select a mapping method (Create
texture (create normally), Create as projection, Create as stencil). If you do not select a
mapping method, the default method (Create texture) is used.
If you are selecting the File texture, map to the image file by clicking the browse icon beside
the Image Name attribute.
38.

Explain the use of specular maps.

(5)

Ans: Some surfaces are shinier than others (for example a wet fish has a shinier surface than a dry
leaf). By mapping a texture to the Specular attribute of an object’s material, you create a specular
map which lets you describe how shine appears on objects (by controlling highlight).Shiny objects
reflect light directly; matte objects diffuse light. Specular highlights show the places on the object
where the light sources are reflected at consistent angles; reflections on an object show, among
other things, light bounced from surrounding objects.
Specular highlights depend directly on the view (camera), not the position of the light, like diffuse
shading does.
The size of a specular highlight on a surface makes the surface look either flat or shiny.
Note: Only materials with specular attributes (Anisotropic, Blinn, Phong, and PhongE) have surface
highlights. The specular highlight is the white shiny glow on the material.
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39.

How to sharpen the images? Explain all its steps in brief.
Ans: The easy and best technique for sharpening uses Photoshop to create a high pass layer and
then layer masks to control where and how much sharpening is applied.
A high pass layer works in the same way an unsharp mask works on film: the high pass layer
creates slightly blurry halos around edges in the original image, thus increasing the contrast at
edges. The difference between high pass sharpening and most other methods of sharpening is that
high pass sharpening does not actually adjust or change any pixels in your original image. Also,
because high pass exists as a separate layer, you can adjust the layer’s Opacity and Blending Modes
to control the strength of sharpening over the entire image. You can then use masks to control
where sharpening is applied within the image and to make localized changes in the strength of
sharpening.
Another advantage to sharpening with a high pass layer is you can save the layer with the
Photoshop file and go back later and change the settings and areas where sharpening has been
applied. This is a huge advantage when working with an image that you might finish for web
viewing and printing, or printing on different papers.
Process:
1. Evaluate the Image: First we need to evaluate the image we are going to sharpen like.,
where the sharpening is needed and the amount of sharpening is needed.
2. Stamp New Layer or Duplicate Your Image Layer: Sharpening is usually the last or
almost the last thing you do when preparing an image, and you want to be sure that you are
applying sharpening to a finished, complete image. Therefore, before making your
sharpening layer, ensure you have a duplicate layer of your completed image.To Stamp
New Layer, check that all layers you want included in your final image are visible (turned
on). Click on (select) your topmost layer and then stretch your fingers to use Command-Alt
Shift-E/Control-Alt-Shift-E to activate the Stamp Visible command and make that stamp a
new layer.
3. Desaturate the High Pass Layer: A disadvantage to sharpening with a high pass layer is
the potential for increasing or adding noise to a photo. With other sharpening tools such as
Unsharp Mask, you can control noise problems with adjustments to the different values set
in the tool. With the high pass option, you control noise by doing three things:
Ensure your image capture is as clean as possible. This means using a tripod if not shooting
at a high shutter speed, choosing the lowest ISO possible, and using the correct exposure. •
Deal with any noise while processing your image. • Desaturate the high pass layer. Even
when working on a colour image, the colour information in a high pass layer is irrelevant,
so we’re going to remove that information right from the top to ensure that extra
information doesn’t add noise.
4. Apply the High Pass Filter: To apply the high pass filter to your sharpening layer, go to
Filter > Other > High Pass.
This will bring up a dialogue box with a Radius slider. You want to increase the Radius
slider (increase the number of pixels affected) until the details in the image just begin to
pop. You’ll find you need more Radius when you’re working with high resolution images.
Don’t be surprised if you need around 10 to 20 pixels or more. Select OK
5. Set the Layer’s Blending Mode: Change the layer’s blending mode in the blending
options drop down menu to Soft Light. As you become more familiar with using high pass
sharpening, experiment with Hard Light and Overlay blending modes as well
6. Adjust the Layer Opacity You will likely find that you now have a bit more sharpening than
you need. That’s okay; starting with 100%, adjust the Layer Opacity down to get the
amount of sharpening you need. Aim for an opacity that gives you the right amount of
sharpening in the area of your image that needs the most sharpening. Add a layer mask by
clicking on the Layer Mask icon at the bottom of your Layers window, or by going to Layer
> Layer Mask.
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(5)

